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Version Control 

Document guide version 1.01 

Relating to Application version 1.01 

Date created 24 July 2021 

Date updated 4 September 2021 

 

Contact details and help 

E-mail ian@willeveltd.co.uk 

Website http://willeveltd.co.uk/ 

Facebook https://www.facebook.com/WilleveOfficeServices 

Application demonstration video https://youtu.be/KVN265YBR_E  

(All menu options. Individual menu option videos 

can be viewed on the website) 

 

Compatibility & system requirements 

This application will function as intended on all ‘Ribbon Versions’ of the Microsoft Office suite, i.e. 2007 

(version 12) onwards. Your operating system should be one of Windows 7, 8, 8.1 or 10. Excel, Word & 

Outlook will need to be installed on your computer in order to use this application. 

 

About this user guide 

This user guide is specific to the demonstration application. A customised version will be supplied with your 

personalised Service Reminder System. 

 

About Service Reminder System 

This application is to be used within Microsoft Excel and is designed to make the administration of your 

regular service contracts as efficient as possible. Your input is stripped back to the absolute minimum and all 

data is stored within the workbook which means issuing wake up emails/letters and reminding on them 

takes a matter of seconds. 

 

This tool is designed to remove the hassle of reminding your customers to book your services. Feedback 

from tradesmen is that this is one of their most detested administration tasks. “If only there was some 

software that could deal with my annual service contracts”, a gas engineer was heard to say. If you are 

creating and sending 50 letters or e-mails each month in order to create work for yourself then, if you are 

doing these manually, you are wasting a lot of time. Running this task on Willeve’s Service Reminder System 
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will take you no more than five minutes, if all reminders are sent by e-mail. Even if you post a proportion of 

‘wake up’ letters, the documents are created, saved and ready to print at the end of the five minutes. Once 

your database is created the only maintenance required is to add new customers and log booked and 

completed services. This housekeeping is vital to the smooth operation of the system. 

 

The application is centred on a database of your client details containing information relating to their service 

contract. Running the reminder functionality once a month will automatically select clients en masse with 

reference to the month in which their services are due and will create and save a ’wake up’ letter, bespoke 

to that client, which will be automatically e-mailed (where an e-mail address is stored within the database). 

Where the client prefers to receive paper communication, the letters can be printed and posted. 

 

This demo is based around the requirements of a boiler servicing engineer, but can be tailored to meet the 

requirements of any business or tradesman who serves their clients on a regular date related basis. Obvious 

other examples would include car services/MOT’s, PAT testing, security system servicing etc. 

 

The Service Reminder menu of the application has 8 functional options, all interlinked, and these will be 

covered in detail within is user guide. 
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Instructions 

Please follow these instructions carefully in order to get the most out of the Service Reminder System application. 

1. Opening and enabling the application 

This application is written in Microsoft Excel and uses Visual Basic for Applications (VBA) code to gather and produce the 

data used to create the quotation and to call the quotation template in Microsoft Word, which also uses VBA code in 

order to create the final document. Whilst this may not mean much to you, or even interest you, it is important that you 

have Microsoft Excel and Word set up in a way that allows the code (known as ‘Macros’) to run. You will also need 

Microsoft Outlook to be configured to use an active email account. 

To check (and amend if necessary) your macro security settings (in both Excel & Word):  

1. On the Developer tab, in the Code group, click Macro Security 

 

 

 

Note: If the Developer tab is not shown, display it on your ribbon by: 

1. Click the File tab, click Options, and then click the Customize Ribbon category. 

2. In the Main Tabs list (on the right of the displayed interface), select the Developer check box, and then click OK. 

 

2. Ensure that your macro settings are as below (or to ‘Enable all macros’, though this isn’t recommended). ‘Disable with 

notification’ means that Macros will be automatically disabled, but you will get a notification whenever you open a 

new Excel file that contains Macros, giving you the opportunity to enable or disable. 
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3.  When opening, if prompted, you should ‘Enable Macros’  

 

Or the security warning may display between the ribbon and the formula bar, depending on your settings: 

 

In which case, you should click ‘enable content’. 

In Excel 2007, you may be presented with this message 

 

In which case, you should click options and select ‘enable this content’. 

 
 

You are now ready to set up your application.  
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2. Setting up the Service Reminder System  

The application will not be functional until you have read and accepted the license agreement. This will be displayed on 

opening the application, once the macros have been enabled, and will continue to be displayed on opening until ‘accept’ 

has been clicked. This can also be called from the menu. 

 

To use the application, there are a few settings that need to be configured and at least four files and two sub directories 

are required. Don’t worry, we will normally do all this for you before delivering the application, so this is really just for 

your information. 

The settings can be found on the ‘Settings’ tab of the main file, highlighted in yellow, and the information should be 

input as follows: 

1. Directory: This is the directory on your computer where the application and associated files are stored. It is 

populated automatically each time the application is opened 

2. Office: This is the directory on your computer where the Microsoft Office program files are stored. It is 

populated automatically each time the application is opened 

3. VAT Rate: Enter the current rate of VAT levied, with no % symbol. At the time of writing, the input here is ‘20’. 

4. Bulk Reminder Doc: This is the name of the control document for your reminder letters.  
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5. Data Source: This is the name of your data source file. 

6. Number of wake ups to send: How many times do you wish your bulk process to remind clients to book their 

service before ceasing correspondence? 

7. Days before reminding: Minimum number of days that need to have passed since you last contacted a client 

before they are included in the bulk process. 

8. Email address to send from: The e-mail address, configured in your copy of Microsoft Outlook, from which your 

reminders should be issued from. 

9. Discount round value: This defines, in conjunction with the following setting, how you wish to round any 

discount applied to your clients (for example, a multi property discount. See below for more information on 

client discounts). 1 will round to the whole pound, 10 to the nearest 10 pounds etc. 

10. Round Up/down/nearest: This defines, in conjunction with the previous setting, how you wish to round the 

discount to be applied. If round value is set as 5 and the exact discount is 32.80 then down will round to 30, up to 

35, nearest to 35 and no rounding will retain 232.80. 

11. Service Level: This is an area where you can set the cost your different levels of service and include extra 

services. Changes to these settings will often require changes to the code in the background to be made too, so 

please discuss with ian@willeveltd.co.uk before making amendments here. 
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The files required are the main application, the data source, the control document and the template. These must all be 

stored in the same directory on your computer, with sub directories named ‘Letters’ & ‘PDFs’ being created too. 

You are now ready to remove the hassle of reminding your clients to book their services. 
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3. Using the application 

To display the Service reminders menu, select the ‘Add-Ins’ tab and the menu will be displayed. Clicking the menu name 

will display the options available. 

 

  

Each of the menu options is discussed in detail below. 
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a) View and edit client details  

View a demonstration video here 

The whole application revolves around your client database, which is why the client options appear at the top of the 

menu. Without the database, the application is of no use, so its creation and maintenance is crucial. If your client 

changes address (or e-mail address) and you don’t maintain the database, then your reminders will go unseen. If you 

don’t update your database when the service is booked and performed, then you risk annoying your clients by reminding 

them to do something that they have already done. 

This menu option allows you to view and edit the details of clients on your database. 

 

This will present you with the ‘View and Edit client details’ form. Firstly, we will look at the method of 

selecting an existing client. 

 

 

The first dropdown, ‘Select Client by’, will give you the option of ordering the ‘Select Client’ dropdown by 

either client reference number (the unique identifier in your database) or client surname. In the example 

above, you’ll see that the clients are ordered by surname. The eagle eyed will notice that some clients 

appear twice, but with different reference numbers. This will be covered later in this document. 

Once you have selected an existing client, the form will automatically complete itself with that clients details 

and all fields, bar the selection dropdowns, are editable. When you click ‘Save’ any changes you have made 

will be written back to your database and the form will close. Pressing ‘Cancel’ will close the form without 

saving your changes. 

It is important that the data is input correctly and completely, so below the image of the form, we will 

discuss the inputs. When you click ‘Save’, your data is checked to ensure it is valid, but only insofar as 

ensuring you haven’t input text into a numeric or date field and that your dates are valid. The data check 

won’t know if you have mistyped an e-mail address or name, so please type carefully and visually check your 

inputs. The validation will highlight any errors that it finds and ask you to correct them before it saves. 

Date inputs will be checked to ensure that they are valid dates. Dates should always be entered as numbers 

in the format d/m/yyyy. E.g. 2021 should be typed as 2021, not 21. 
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All examples in the input discussion will be based on the client shown in the form. 

 

1. Title: Customers title. Select from the dropdown list. 

2. Initials or Forename: If you wish to address the client formally on your correspondence, e.g. Dear Mr 

Clough, then enter the clients initial(s). If you wish to address them in a more familiar manner (e.g. Dear 

Nigel) then enter their forename. 

3. Surname: Customers surname. 

4. Greeting: Use the dropdown to select from Formal or Familiar, depending on how you wish to address 

your client. Please see item 2. 

5. E-mail address: Customers e-mail address. 

6. Telephone number: Customers telephone no. 

7. Address Lines & Postcode: Customers correspondence address. 

mailto:ian@willeveltd.co.uk
http://www.willeveltd.co.uk/


 
ian@willeveltd.co.uk    www.willeveltd.co.uk 

Services provided by Willeve Limited, trading as Willeve Office Services. Registered in England & Wales Company no. 12067675 

8. Are correspondence and site address the same: Many of your jobs will be located away from your 

customer’s correspondence address. Select yes if the job is at the correspondence address, which will 

automatically populate the site address, or No if the site and correspondence address differ, which will 

then display fields into which you will be able input the site address. In the example above, we have 

selected No and hence the inputs discussed in 9, below, are visible. 

9. Site address lines and postcode: This will only be displayed if you selected ‘No’ in field 8 and should be 

completed with the site address. 

10. Landlords certificate: Select yes or no from the dropdown to record whether your client requires a 

Landlords Certificate to be issued when you perform the service, the price of which is defined on the 

settings tab (see section 2 above) 

11. Client Discount: Some clients may enjoy a discount on their service when compared to your standard 

pricing if, for example, you service multiple properties for them (more on multiple properties later). If 

you do give a discount to this client, enter the percentage here. If you don’t, then leave blank. If you are 

withdrawing a discount, be sure to clear the input. 

12. Communication method: How will you communicate with this client? Select either E-Mail or Letter from 

the dropdown. If you select e-mail please ensure that the correct e-mail address has been entered in 

input 5. 

13. Service level: In this example, Gas Service Limited offer three levels of service contract, the names and 

prices of which are defined on the settings tab (see section 2 above). 

14. Month of Service: Which month of the year is the service due? 

 

Each of the following values can be created by other process all of which, where referenced, will be 

discussed later in this document. You can, if you wish and where applicable, update the data here 

rather than going the bespoke process, though the menu options have been designed to be more 

efficient than manually updating here as they often update more than just the one field. For example, 

marking a service as complete will, besides updating the ‘last service’ field, also clear the ‘Booked’ 

and ‘paid’ fields, ready for next year, and update the ‘next service due’ field with the 1st of the 

service month in the following year, ready to be picked up by the bulk process. 

 

15. Last service: This will show the date that the last service was performed. When adding a new client (see 

below) this will need to be added manually, but future updates will be done automatically when you 

mark the service as having been performed, using that menu option.  

16. Wake up sent: This will be automatically populated within your database when the client is picked up by 

the Bulk ‘Issue Wake ups’ process or by the single client remainder process. 

17. Number of wakeups: This records how many reminders have been sent. When the count reaches the 

value input in the settings tab (see section 2 above), the client will no longer be included in the bulk 

wake up process. 

18. Date service booked for: When a client books their service this should be populated, either using the 

dedicated process or through this form, to ensure that they are not reminded to do something they 

have already done if the next bulk run is performed before the service, which is quite likely if you are 

booking 2 or 3 months in advance. 

19. Date Paid: Update using the dedicated process when your client has paid to enable you to keep track. 

20. Next service due: When you first add the client, populate this field with the date that you will be doing 

the first service (though it doesn’t matter if it’s left blank as the functionality works from item 14, 

above). This field will subsequently auto populate once the service is marked as complete. 

When you are happy with your changes, click ‘Save’  
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b) Add a Client 

View a demonstration video here 

To add a new client from scratch, click ‘Add a client’: 

 

This will present you with the same form as before, but the existing client selection dropdowns will not be functional. 

You should use the form to add a new client, completing the fields in the manner described in section 3a. 

c) Copy a client (2nd site address) 

View a demonstration video here 

This was briefly touched upon in section 3a, when we mentioned client discounts for multiple properties in field 11. You 

should use this option if an existing client is adding an additional property to your service portfolio. This option means 

you can add a new property for your client without having to complete all of the client details. 

 

This will again display the same form discussed in sections 3a and 3b and you should use the same method 

as previously described to select your client. 

Once you have selected the client to copy, the form will populate with the clients details and automatically 

set the ‘Are correspondence and site address the same’ indicator to no and display blank ‘site address’ fields. 

Simply complete the site address and as necessary and click save. 

When an additional site address is added for a client, that address is allocated its own client reference 

number and so appears as an entry in its own right on your database. However, the client reference of the 

parent record (i.e. the record you choose to duplicate) is stored on the new record in column AM, so I would 

recommend selecting the client’s first record each time you create a duplicate. In the screenshot below and 

using ‘Mr Mark Fowler’ as an example, record 3 is the original record and record 19 is a duplicate record for 

an additional property. I would recommend selecting record 3 every time you add a property for this client. 

In this demo version, the parent record number drives nothing and is for information only, but you may have 

some bespoke requirements that necessitate grouping properties of a single client which will mean 

consistency of data recording is vital. 
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d) Delete a client 

View a demonstration video here 

Unfortunately, and for a variety of reasons, you will lose clients over time and you’ll want to delete these 

from your database to avoid issuing reminders. 

 

On clicking the menu option you will be presented with the ‘Delete a client’ form. Simply select the client to 

remove, in line with the method previously discussed, check the customer details are as you wish and click 

‘Delete this client’ and the record will be permanently removed from your database.  

 

e) Issue 'wake up' letters (Bulk) 

View a demonstration video here 

This function is, of course, the main purpose of the software. Once your data has been entered (and 

maintained!) you will be using this option to create and issue your monthly reminders in 2 or 3 minutes 

rather than spending hours doing the job manually. 

 

Despite being the main feature of the software, the process is very simple, just as long as your data is 

maintained – a point that will continue to be emphasised. It is vital for the functionality of the software that 

your database is updated with booked and completed services prior to performing your monthly reminder 

run.  
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Use the dropdown to select the month in which services are due that you wish to wake your clients up for 

and decide whether to include clients from earlier months who are yet to respond (subject to them not 

having already been reminded the number of times that you have specified in the settings, as discussed in 

part 6 of ‘Setting up the Service Reminder System’) and click proceed. 

The software will produce a letter for each service due in the month you have selected (in both Word and 

PDF format) and, where e-mail is defined as the communication method in your database, will email the 

letter to your client as an attachment. The Word version of the letters will be left open on your desktop, for 

you to print, review or close as necessary, and both versions will be automatically saved in the ‘letters’ and 

PDFs’ directories of the application for future reference. 

Within your database, the ‘Wake up sent’ column (R) will be updated with the date that the letters were 

created and the ‘No. of wake ups sent’ column (S) will be incremented to reflect how many reminders have 

been issued. 

f) Issue an individual 'wake up' letter 

View a demonstration video here 

This function is similar to the bulk process discussed above, but enables you to select and individual client 

(using the method previously discussed) and issue a wake up just to them. Letter production and e-mailing 

and database updates function in exactly the same way as for the bulk process. 

 

Having selected the client you will be shown some information about this contract and asked to confirm your 

request. 
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g) Mark a client as service booked or paid 

View a demonstration video here 

Having issued reminders to your clients to arrange their service, you will now be booking in those services. It 

is important that you update your database when these bookings are made to avoid issuing further 

reminders to clients who have already contacted you. Re-issuing reminders in this circumstance is a sure fire 

way to irritate your customers. This option is also used to update the client record to show that they have 

paid. 

 

Having selected the client (using the method previously discussed), you will be presented with the input 

shown below. Please enter the details in the format shown to the right of each input box. For the date paid 

option, you can simply click the ‘use today’ button. 

 

On clicking proceed, the ‘Booked’ column (T) and ‘Paid’ column (U) will be updated with your inputs. The columns 

containing ‘Last service’ (Q), ‘Wake up Sent’ (R), ‘No. of wake ups’ (S) and ‘Next Service due’ (V) will be cleared in 

preparation for future use. 

h) Mark a client as service performed 

View a demonstration video here 

Once the service has been performed, you should select this option to set the database ready for next years 

reminder. 

 

Having selected the client (using the method previously discussed), you will be presented with the input 

shown below. Please enter the details in the format shown to the right of the input box or click the ‘use 

today’ button if that is relevant. 
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On clicking proceed, the ‘Last Service’ column (Q) will be updated with your input. The columns containing ‘Booked’ (T), 

‘Paid’ (U) will be cleared and the ‘Next Service due’ column (V) will be updated in preparation for future use. 

i) About and review license 

These have no functionality and merely provide application information and an opportunity to review your usage license. 

 

Other possibilities and future additions 

1. Whatever you want 

We have included the basics in this software, but we are not gas service engineers so need you to tell us, 

what do YOU want? This application is designed to liberate you from paperwork, not to enslave you, so tell 

us your requirements and we’ll tell you, firstly, if we can do it (the likelihood is that we can!) and, most 

importantly, whether it will be cost effective for us to do so. 

 

If you have been using the system for a while and find yourself wondering why it doesn’t do something that 

would be particularly useful for YOU, then please contact us to discuss your requirements. 

 

For full details of how the demo application has been configured (and how it could be configured) and to 

understand the possibilities available so that the Service Reminder system can work for YOU, please visit 

http://willeveltd.co.uk/examples.html  

 

© All text and images are the copyright of Willeve Limited 
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